
1/12 Printed on 2024/01/26 21:19

Inhaltsverzeichnis
4 Importing an assembly 3 ................................................................................................................. 

4.1 Dialog window "Import assembly into Teamcenter 3 .......................................................... 
4.1.1 "Default settings" group 3 ....................................................................................................... 
4.1.2 Group "Parts to be imported" 4 ............................................................................................... 
4.1.2 "Other parameters" group 5 ................................................................................................... 
4.1.4 "Import DFA files" group 6 ...................................................................................................... 
4.1.5 "Check and test run" group 6 .................................................................................................. 
4.1.6 Group "Name and attributes for importing parts" 7 ................................................................ 
4.1.7 "Teamcenter Information" column 7 ....................................................................................... 

4.2 Importing an assembly into Teamcenter 8 ............................................................................ 
4.2.1 Importing an assembly 8 ......................................................................................................... 
4.2.2 Importing an assembly with a family of parts 8 ...................................................................... 
4.2.3 From Exceptions to attributes of imported parts 9 ................................................................. 

4.3 Procedure 10 .............................................................................................................................. 
4.3.1 Importing an assembly 10 ....................................................................................................... 
4.3.2 Import an assembly with a family of parts 11 ......................................................................... 
4.3.3 Importing a part with a drawing 12 ......................................................................................... 



2024/01/26 21:19 2/12 4 Importing an assembly

2/12 Printed on 2024/01/26 21:19



3/12 Printed on 2024/01/26 21:19

4 Importing an assembly
4.1 Dialog window "Import assembly into Teamcenter

4.1.1 "Default settings" group

Options Description
Element Type Sets the default element type for imported parts

Use type from part
file

Selects the element type to import based on the element type of the part
file. This ensures that the imported part has the same element type as
when it was exported.
When multiple parts are selected and the parts have different element
types, the correct type is automatically assigned based on the information
in the part file.
The following priority order is used to retrieve the element type of the part
file:
1. part file type (if the type is present in the part file)
2. log file type (if the log file is used)
3. standard element type
Teamcenter preferences TC_default_part_type
Note:
→ This option must be selected before selecting parts.
→ This function only applies to parts created in NX10 or higher.

Convert names and attributes
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Numbering source

Specifies the method for numbering imported parts. Depending on the
method you choose, various inputs are available that you can use to specify
the imported attributes.
The Default Name, Default Description, ID Attribute, and Revision
Attribute attributes use the information from the parts you import. You
can add your own values for these attributes to change them. If an empty
string occurs, an automatically generated value is used.
→ Part ID Generator: Generates and automatically assigns new part
numbers. This is similar to automatically assigning a new part number
when creating a new part in the File (File) → New (New) dialog box.
You can change the attributes Default Name) and Default Description).
→ BS filename (OS Filename): Uses the same filename as in the
operating system. If you specify this method, you can also specify a
conversion rule to change the file name.
With Conversion Rule), you can use the BS file name as a base and add a
prefix or suffix, replace a string, or simply use the element ID.
You can change the attributes Default Name and Default Description.
Note:
→ BS filename (OS Filename) with the setting As ID and Conversion
Rule for conversion rule (As ID and Revision) is identical to the
automatic conversion of names in previous NX versions.
→ The custom functions registered for automatic conversion are called
when the naming is applied during import.
Attribute (Attributes): Uses the attribute values stored in the part.
Note:
You can enter ${OS_FILENAME} for any attribute to use the file name in the
operating system. For example, you can replace ${DB_PART_NAME} with
${OS_FILENAME} for the Default Name attribute.
If naming rules have been associated with the Teamcenter item_id
(attribute ID in NX) property that conflict with OS_FILENAME or
DB_PART_NAME (whichever attribute is used), an error message is
displayed. For these incorrect elements, you can override the ID (ID)
naming method by manually entering the ID (ID) that matches the naming
rule pattern, or by using automatic assignment.

Components
Include component
parts Add components to the imported assembly.

Include dependent
parts Add dependent elements to the imported parts.

Find Components

Determines the versions of components of an assembly that are loaded.
Available for selection:
→ As stored
→ From folder
→ From search folder

4.1.2 Group "Parts to be imported"

Options Description

Select Assemblies
or Parts

Opens the Select Parts dialog box so you can select the assemblies and parts
to import. When you click OK, the parts, assemblies, and assembly
components appear in the Import List on the right side of the Import
Assembly into Teamcenter dialog box.
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Select log file for
setting up import

Opens the dialog box for selecting parts so that you can select a log file as
input. The log file contains a list of the parts and assemblies to be imported.
The dialog box filters the files according to the extensions .clone and .log.
When you click OK, the parts, assemblies, and assembly components are
searched in the clone file and displayed in the Import Assembly into
Teamcenter list on the right side of the dialog box Import Assembly into
Teamcenter.

Import from Folder
Opens the Select Parts dialog so you can select a folder containing the parts
and assemblies you want to import.

4.1.2 "Other parameters" group

Options Description
Save parameters

Publish Optional
Information

Completely loads assemblies and publishes the following:
→ QAF Files
→ TruShape Data
→ UGPART Attribute Form
→ Limiting Frames
→ Weld Form Elements. The type of welds depends on the selected user
standards for welds. Welding elements are not supported.
→ Product Interfaces
→ Synchronized Assembly Arrangements
The Option Publish Optional Information* has no influence on the
publication of WAVE and drawing relationships during import. They are only
published for parts that are fully loaded, regardless of whether this option
is enabled or not.
If the option Publish Optional Information) is not selected, the only
publishing option on import is the option Save JT Data) (in the Save
Options dialog box ) when JT files are created.
By publishing the optional information, the option Publish Optional
Information affects performance when loading the assembly. It is
therefore not selected by default.
You cannot select the Publish Optional Information option after you
have specified the items to import. If Publish Optional Information is not
selected, and you perform an action to select the import items, such as
adding an assembly or importing from a folder, the option is inactive.

Standard parameters

Action for existing
part

Defines how the parts are imported into the database for existing parts.
→ Overwrite - If the same part already exists in the database, it will be
overwritten with the imported part.
→ Use existing ones - If the same part already exists in the database, it
will not be overwritten. The existing part is reused.
→ New Change State - If the same part already exists in the database,
the new parts are imported with a new change state. The next change
status in the sequence is used as the new change status.

Default destination
folder

Defines the default folder in Teamcenter in which imported items will be
placed. The setting is saved so that it can be recalled for all NX sessions.
When you navigate to the folder, you can display the Home node with the
folders below it. It is also possible to specify a folder outside your personal
folders (Home) by manually entering the folder in the text box. However,
you must have write permissions for the folder to do this.
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Output log file

Allows you to specify a log file in which the import operation is recorded.
This is information that is also displayed in the Information window when
the import is complete.
Use Browse to specify a name and select the directory where the log file
will be placed. The .clone extension is added automatically.

Linked Files root
directory

Defines the folder in the OS where the linked files are located. You can
select the folder with Browse.

Default Owner Defines the owner of the parts and assemblies being imported. By default,
this is the user name for the Teamcenter login.

Default owner group Defines the owner group of the parts and assemblies to be imported. By
default, this is the user group for Teamcenter logon.

Standard Projects
Opens the Assign to Project dialog box, where you can select the
projects to which the imported parts belong.

Validity check

Validity check

Specifies how check results are imported when importing NX parts.
These are:
→ Off (Off)
→ Import from Part (Import from Part)
→ Run Validation (Run Validation)
→ Run Validation (Hybrid) (Run Validation (Hybrid))
This option allows you to improve validation performance by avoiding re-
validation of part files that already have saved results.

Browse option
„Validation rule
record file“

Specifies whether the file that contains the validation rules is in
Teamcenter or in the native NX application (operating system).

Set Check Rule Record
File

Sets the folder in the OS where the check rule record file is located. You
can select the folder with Browse. The dialog box filters the files according
to the extension .vrx.

Process warning as
success

Indicates whether the status With warning passed should be accepted in
Check-Mate.

Process old as
success

Gives whether the status Existed but outdated should be accepted in
Check-Mate.

Cancel import on
error Cancels import of parts if a check rule is not observed.

4.1.4 "Import DFA files" group

You can access DFA files in native directories and in Teamcenter folders. For more information about
DFA files, see the Knowledge Fusion documentation in the NX Help.

Options Description
Add DFA Inserts Indicates whether dependent DFA files will be imported.
Add DFA Files Opens the DFA Files dialog box so you can select DFA files to include in the import.
Added DFA files Lists the selected DFA files. You can also remove unwanted files 

4.1.5 "Check and test run" group

Options Description

 CheckTeamcenter
information

Checks the validity of parts during the test run based on the options
selected in the Other Parameters group, Validity Check subgroup.
Also updates the Teamcenter Information column in the list window.
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 Test run

Executes a test run of the import operation before you perform the
correct import. The information window informs you about the results
of the simulated import.
Key attributes are locked after a test run and cannot be changed.

4.1.6 Group "Name and attributes for importing parts"

Options Description

List field

Displays the parts and assemblies selected for import. You can change attributes
for individual elements or select a column and change an attribute for all
elements. Right-click a column header to change the order of the columns and
add and delete columns.
Note:
In the dialog window Import assembly into Teamcenter the table editor
functionality is used.
Explanations of the additional columns:
→ The Subcondition column indicates the condition of the part during the import
process, e.g. „Part Family Element“, „Not Master“, „Name Only“, etc.
→ The Reason for Consideration column indicates why a part is included in the
import process or included in the list. This can be the case because it is the
component of an assembly, the family element of a part family template, and so
on.
→ The column Teamcenter information indicates what happens during the
import process. To display data in this column, you must perform a test run

 Secondary
attributes

Displays the dialog window Attributes. Allows changes to attributes for the

imported parts and assemblies. An attribute with a check mark  is a required
attribute to which a value is assigned.

 Reset
attributes

Deletes the attribute values for rows selected in the list box. This allows you to
apply different attributes to selected rows. You can select multiple rows to be
reset.

 Projects
Opens the Assign to Project dialog box, which displays the projects available in
Teamcenter. All projects in which you are a member are displayed. You can select
one or more projects for the new item.

 Select
existing part

Selects the existing part and its properties when re-importing a part, which are
automatically applied to the imported part. Use this option instead of assigning
attributes using options or entering values manually.
If you select the row for a part (and the part is not a family element or non-
master), this option becomes active.

4.1.7 "Teamcenter Information" column

In the Name and Attributes for Parts group in the list window, the Teamcenter Information column
informs about the action to be performed during part import.

Examples of such actions are:

This part family element is treated as lost.
Non-master of the element ID/change status ID.
The specified element already exists in Teamcenter. A new change status is created for this
part.
A new element is created for this part.
The specified item change status already exists in Teamcenter and is used.
The specified element change status already exists in Teamcenter and is overwritten.
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The specified element already exists in Teamcenter and is not imported because it is a Name-
Only element.
The specified item change state already exists in Teamcenter and is not imported because it is
a Name Change State Only.
The part is not imported because it is a name-only part.

4.2 Importing an assembly into Teamcenter

4.2.1 Importing an assembly

Use the Import Assembly to Teamcenter command to import a part or assembly from the
operating system into Teamcenter. For each NX part, elements, element change statuses and
datasets are generated as required. The parts and structure for an assembly are created in
Teamcenter.

When you import the part or assembly, you can specify the following:

Procedure for naming imported parts.
Inclusion of component parts or dependent parts of assemblies.
Use a log file to list parts.
Ownership and validation options.
Target options in Teamcenter
Inclusion of DFA files.

When you use this command, you first set some of the options and then select the assemblies and
parts to import. This allows the functionality of the selected options to be applied to the assemblies
before they are listed in the dialog box.

Note:

Assemblies imported into Teamcenter using the Import Assembly into Teamcenter
command do not contain relationships that were set up in the original assembly. To apply
the relationships, you must first load all parts and then save the assembly to NX.

A number of user standards are available that allow you to set preferred default settings to simplify
the import process.

Where can this function be called?

Application Teamcenter Integration
Menu bar Import an assembly into Teamcenter

4.2.2 Importing an assembly with a family of parts

If you import an assembly into Teamcenter that was created in the native NX application and contains
a part family, you must perform the import operation correctly before you open the assembly,
otherwise some elements of the part family may be missing from the assembly. The part family items
may appear as dimmed instances in the Assembly Navigator that you cannot open.
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To ensure that the part handles of templates are internally correctly assigned to new part handles
when imported into the parent assembly, you must first add the assembly for import and then the
template part to the part family for the same import process. When you open the assembly, the
elements of the part family can be created and the child instances can be coupled to these elements.

4.2.3 From Exceptions to attributes of imported parts

You can create exceptions for the attributes of imported parts by changing the attributes individually
or by changing the attribute naming method used for the selected parts. This allows you to apply
different naming techniques in a single import process.

In the group Name and attributes for parts to be imported the parts to be imported are listed
and the attributes are filled depending on the selection in the group Name and attribute
conversion.

4.2.3.1 Changing assigned attributes

If attributes have been assigned, you can customize the parameters in the Name and Attribute
Conversion group to change the assignment of the attributes and then reassign the attributes.

Click a row number to select the attributes for a part. Then click Reset Attributes  to
deselect the attributes. Double-click an attribute to select attributes in the row based on the
parameters selected in the Name and Attribute Conversion group.

Note:

You can use the CTRL key or select multiple lines by dragging the mouse with the mouse
button pressed down.

To change all attributes in the table, click the upper left corner of the table to select the entire

table. Then click Reset Attributes  to deselect the attributes.

You can double-click attributes that are not locked after assignment and enter the new value
manually.

Attributes can no longer be reset after a test run has been performed. In addition, key attributes are
locked and can no longer be changed.

4.2.3.2 Automatic assignment of attributes to parts that have been selected for import

When you select parts for import, the user default automatically assigns Automatic Part Attribute
Mapping when you add parts to import attribute values based on the selection in the Name and
Attribute Conversion group.

If the user default is not selected, the attributes for the selected parts are empty and must be added.
You can edit and enter values for each attribute manually, or double-click to make the assignment for
each attribute. The assigned values are based on the parameters of the Name and Attribute
Conversion group.
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4.2.3.3 Attributes locked after assignment

The ID and Revision attributes take into account the Teamcenter preferences that control the ability
to change the item ID and change state in My Teamcenter. You can use the preferences to change the
attributes after the value is assigned.

The Teamcenter preferences are:

ASSIGNED_ITEM_ID_MODIFIABLE
Allows you to change the ID cell in the Import Assembly to Teamcenter dialog box after the value is
assigned. If the setting is 0 (default setting), the value cannot be changed. If the setting is 1, the
assigned value can be changed.
ASSIGNED_ITEM_REV_MODIFIABLE
Allows you to change the cell Change Status in the Import Assembly to Teamcenter dialog box
after the value is assigned. If the setting is 0 (default setting), the value cannot be changed. If the
setting is 1, the assigned change status can be changed.

4.3 Procedure

4.3.1 Importing an assembly

1. Choose in the tab File →  Import assembly into Teamcenter.
2. Select the entry Element in the Default settings group in the Element type list.

Note:

FFG Engineering Item is selected by default.

3.
Select under Names and Convert attributes in the list Numbering source the entry BS
filename (OS filename).
Then the assembly and its components with the filename are imported from the operating system
as a basis for the imported elements.

4. Select the entry As ID and Change Status in the Conversion Rule list.

5. Leave the default name and Default Description empty to use the existing name and description
attributes for the imported items.

6.
Select the following in the Components group:
→ Include Component Parts
→ Include Dependent Parts

Note:

If you also import component parts and dependent parts, you must select the Include
component parts and Include dependent parts check boxes before selecting the
assemblies to import.

7. Click Find Components to display the Assembly Loading Options dialog box.
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8. Select the entry As Saved from the Load list.

9. In the Parts to import group, click Select assemblies or parts  and select the assemblies
and parts you want to import.
The assemblies and parts are listed in the group Name and attributes for parts to import.

Note:

In the dialog window Import assembly into Teamcenter the table editor functionality
is used.

10.
Select in the group Other parameters under Standard parameters in the list Action for
existing part the entry New Change state.
Then the parts are imported with a new change status and existing parts in the database are not
overwritten.

11.
Under Default Parameters, in the Default Destination Folder box, type the path or navigate
to the folder in Teamcenter where the imported items will be placed.
You can manually enter a folder that is outside your personal folder in the field, but you must
have write permissions to the folder.

12. Enter the path under Default parameter in the Output log file field or navigate to the
directory containing the log file.

13. (Optional) You can change the default owner and the default owner group if you have the
appropriate permissions.

14. Under Default Parameters, click Projects .

15.
Select a project in the Assign to Project dialog box and then click OK.
The list contains the projects that are available in Teamcenter and of which you are a member.
You can select one or more projects.

Note:

You can change the assignment of projects later by selecting the File → Utilities →
Projects tab.

16.
Click on Test run  to perform a simulated import.
After completion of the simulated import process, the Information window displays how the
parts and assemblies were imported. In the Information window, check that all information,
including import action, naming technique, directory path, etc., is correct.

17. Close the Information window.
18. In the Import Assembly to Teamcenter dialog box, click OK to start the import.
19. Check in the window Information, whether the import took place as expected.
20. Display the imported items in Teamcenter Navigator.

4.3.2 Import an assembly with a family of parts

When you import an assembly with elements of a part family, it is assumed that the assembly was
exported from Teamcenter with the Automatic Conversion option and that the elements of the part
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family were replaced by the part family template during export.

1. Choose in the tab File →  Import assembly into Teamcenter.

2. In the Parts to Import group, click Assemblies or Select Parts  and select the template
part of the assembly and part family.

3. Select the entry BS file name under Convert names and attributes in the Numbering source
list.

4. Select the entry As ID and Change Status in the Conversion Rule list.

5.

Select the other options in the Import Assembly to Teamcenter dialog box as required and
perform the import.
The DB_PART_NO database attribute created during import for the part family element matches
the DB_PART_NO attribute stored in the template part for the part family element. This ensures
that the correct family item is found in the database when items are regenerated from Teamcenter
during later loading operations.

4.3.3 Importing a part with a drawing

If you set the user standard Treat part with drawing sheet as Non-Master and then import your
parts into Teamcenter using the command Import an Assembly in Teamcenter, the parts that
contain drawing sheets are automatically identified as Non-Master Parts during the import process.

Note:

NX informs you that the drawing parts will be converted to non-master.
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